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• Overview: A new version of Outlook

• What’s changed and why

• Find everyday commands

• Send and receive attachments and pictures
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Overview: A new version of Outlook

Making the Switch

Look out! There’s a new version of 

Outlook. 

It has a whole new look along with new 

features. But don’t worry, that doesn’t 

mean you’ll need to spend a lot of time 

learning a new program. 

Instead, the new design and new 

features will help you more efficiently 

and easily accomplish the tasks you 

do in Outlook every day. 

Course goals

• Move around in Outlook 2007. Learn about the 

things that have changed, and why. 

• Find commands on the Ribbon and do the things you 

do every day: read and send e-mail, work with 

appointments and meetings, and use your contacts. 

• Send and receive pictures and attachments. Ensure 

that recipients will be able to open attached files that 

use the new 2007 Microsoft Office release file 

formats. 

Making the Switch
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What’s Changed and Why

What’s changed and why

Making the Switch

The first time 

you create a 

message in 

Outlook 2007 

(or open one 

you receive), 

you’ll see the 

Ribbon.

It’s the band 

across the top 

of the window. 
One of the most dramatic changes in Outlook, the 

Ribbon gives Outlook its new look. 

But as you get up to speed, you’ll see that the change 

is more than visual—it’s there to help you get things 

done more easily and with fewer steps. 



2/22/2008

4

Introducing the Ribbon

Making the Switch

A new e-mail 

message --

The Ribbon is 

at the top of 

the window.

The Ribbon is 

visible each 

time you 

create or edit 

something in 

Outlook. 
Why the new system? Microsoft carefully researched 

how people use commands in Outlook. 

As a result of that research, some Outlook commands 

are now more prominent, and common commands are 

displayed and grouped in ways that make them easy to 

find and use. 

A closer look at the Ribbon

Making the Switch

To better help 

you learn how 

to use the 

Ribbon, here’s 

a guide to its 

basic 

arrangement. 

1

2

3

Tabs: The Ribbon is made up of different tabs, each 

related to specific kinds of work you do in Outlook. 

Groups: Each tab has several groups that show related 

items together.

Commands: A command is a button, a box to enter 

information, or a menu. 
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The Ribbon shows what you need

Making the Switch

You’ll encounter 

the Ribbon when 

you take certain 

actions such as 

creating 

messages, 

calendar entries, 

or contacts. 

The Ribbon shows tabs and commands appropriate for 

what you’re doing.

That is, the tabs on the Ribbon will differ depending on 

the area of Outlook you’re working in. 

The Ribbon shows what you need

Making the Switch

The picture 

shows some of 

these 

differences. 

1

2

3

A new message shows the Message and Options tabs. 

A new appointment shows the Appointment tab. 

A new contact shows the Contact tab. 
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There’s more than meets the eye

Making the Switch

A small arrow 

at the bottom 

of a group 

means there’s 

more available 

than what you 

see. 

This button     

is called the 

Dialog Box 

Launcher.
The picture shows that to see a full list of font options, 

you’d click the arrow next to the Basic Text group on the 

Message tab of a new e-mail message.

The Mini toolbar

Making the Switch

The Mini 

toolbar allows 

you to quickly 

access 

formatting 

commands right 

where you need 

them: in the 

body of an 

e-mail message. 

1

2

Select your text by dragging with your mouse, and then 

point at the selection. 

The Mini toolbar appears in a faded fashion. If you point 

to it, it becomes solid. You can click a formatting option. 

The picture shows how it works:
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The Quick Access Toolbar

Making the Switch

The Quick 

Access 

Toolbar is a 

small toolbar 

above the 

Ribbon. 

It’s there to 

make the 

commands 

you need and 

use most often 

readily 

available. 

What’s best about the Quick Access Toolbar? What’s 

on it is up to you. 

That is, you can add your favorite commands to it with 

a simple right-click. 

The Quick Access Toolbar

Making the Switch

You’ll see and 

use different 

Quick Access 

Toolbars 

depending on 

the area of 

Outlook that 

you’re 

working in. 

For example, customizations that you make to the Quick 

Access Toolbar for messages you send will not appear 

on the Quick Access Toolbar for Contacts.  
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Keyboard shortcuts

Making the Switch

If you use 

keyboard 

shortcuts 

instead of a 

mouse or other 

pointing device, 

you’ll noticed 

that some 

shortcuts are 

the same but 

that others have 

changed. With the introduction of the Ribbon, commands are in 

new locations, so shortcuts that begin with ALT will 

probably be different from earlier versions. 

Keyboard shortcuts

Making the Switch

To find your way around:

1. Start by pressing ALT. 

2. Press the indicated key to see the correct tab, and 

then press the letter to access the command you 

want. 
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Know your options

Making the Switch

Outlook 

provides many 

options to help 

you change how 

things look and 

work.

The way you 

access these 

program options 

hasn’t changed. 
As shown in the picture, you’ll still click Options on the 

Tools menu from within the main Outlook window and 

use the Options dialog box.

More about options

Making the Switch

In Outlook 

2007, you set 

options from a 

few different 

locations. 

Options for writing e-mail

If you want to change your settings for writing e-mail—

for example, to make the spelling checker stop ignoring 

words in uppercase—you do that from the Editor 

Options dialog box. 
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More about options

Making the Switch

In Outlook 

2007, you set 

options from a 

few different 

locations. 

1

2

Click the Microsoft Office Button      .

Start by creating a message, and then do this:

Click Editor Options. 

More that’s new: the To-Do Bar

Making the Switch

Located at the 

far right of the 

window, the 

To-Do Bar is 

visible 

wherever you 

happen  to be 

working in 

Outlook. 

The To-Do Bar is there to help you keep track of 

upcoming tasks and appointments.
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More that’s new: the To-Do Bar

Making the Switch

Located at the 

far right of the 

window, the 

To-Do Bar is 

visible 

wherever you 

happen  to be 

working in 

Outlook. 

The picture calls out a few of its key elements: 

1

2

3

Date Navigator

Upcoming calendar appointments

A place to enter new tasks by typing

Your task list4

A new look for the calendar

Making the Switch

The new 

design of the 

calendar in 

Outlook 2007 

makes it 

easier to see 

what’s what. 

Moving 

around is 

easier, too. 

1

2

Bigger buttons make it easier to quickly switch between 

daily, weekly, and monthly calendar views.

Back and Forward buttons let you quickly go to the next 

day, week, or month in the calendar.

The picture shows some examples:
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A new look for the calendar

Making the Switch

The new 

design of the 

calendar in 

Outlook 2007 

makes it easier 

to see what’s 

what. 

Moving around 

is easier, too. 

3 Also new is the Tasks area. It shows your current and 

upcoming tasks and tracks your accomplishments, too. 

The picture shows some examples:

A new look for contacts

Making the Switch

In Outlook 2007, 

Electronic Business 

Cards make contacts 

easy to view and easy 

to share. 

You’ll first notice the new look for contacts when you 

click Contacts to switch to that area of Outlook. 
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A new look for contacts

Making the Switch

Notice that in this 

picture, the Navigation 

Pane is minimized to 

show more of the 

Contacts pane.  

You can minimize the Navigation Pane from any area of 

Outlook by clicking the Minimize the Navigation Pane

button.  

Find Everyday Commands
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Create a new message

Making the Switch

It’s time to write 

and send your 

first e-mail 

message using 

the new 

Outlook.

What do you 

need to know? 

For starters, 

some things 

haven’t 

changed.

The first thing you need to know to get started is that you 

don’t need to know anything new. All of the old ways to 

start a new message still work. 

In a new message, first get oriented to the Ribbon. The 

Message tab is on top, with the commands you’re most 

likely to use every time you create and send a message..

Create a new message

Making the Switch

Using other 

tabs

For example, to insert a picture so that it appears in line 

with the text of your message (not as a separate 

attachment), you’ll need to switch to the Insert tab. 

If you’re having 

trouble finding a 

command or 

button, you may 

need to look on 

another tab. 
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Use the Address Book to add recipients

Making the Switch

Do you use 

the Address 

Book to add 

names to the 

To, Cc, and 

Bcc fields?

You’ll find the Address Book command on the 

Message tab. 

Show or hide the Bcc field

Making the Switch

If you prefer to 

type 

e-mail 

addresses 

directly in the 

To and Cc

boxes, you 

may also want 

to know how 

you can show 

the Bcc field 

so that you 

can type 

names there, 

too. 

The picture shows the location of the Show Bcc 

command. 

As you can see, you’ll find it on the Options tab.
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Include your signature

Making the Switch

Do you use a 

personal e-

mail signature 

at the end of 

your Outlook 

messages? 

The same signature you used in earlier versions will be 

available when you upgrade to Outlook 2007.

If you didn’t use signatures (maybe they seemed too 

complex or you could never remember how to create 

them or where to find them), you’ll be surprised to see 

how easy signatures are in Outlook 2007.

Include your signature

Making the Switch

You can modify 

existing 

signatures or 

create new 

ones, as well as 

set a default 

signature.

The picture shows what happens next:

1

2

If you created signatures previously, you’ll see them 

listed here.

To create new signatures, set a default signature, or 

modify existing signatures, click Signatures.

Start by clicking 

the arrow under 

the Signature

command.
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Use flags and reminders

Making the Switch

Flags and 

reminders can 

help you and 

others 

remember to do 

things. 

To add a flag, reminder, or both when you’re creating a 

message, start by clicking Follow Up in the Options

group of a new message. 

Use flags and reminders

Making the Switch

Follow up for 

yourself

To be sure that you remember to do that, flag the 

message for yourself by clicking Follow Up and then 

clicking Tomorrow. 

The message is flagged and added to your To-Do List in 

Tasks. It also shows up as an item in your own To-Do 

Bar.

Suppose you 

send a 

message to a 

colleague that 

says 

―I’ll follow up 

with you 

tomorrow.‖ 
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Use flags and reminders

Making the Switch

Follow up for 

the recipient

Before you send the message, you specify when you 

want the recipient to be reminded to follow up with you.

As the picture shows, the received message will include 

a flag and the bell icon. As long as the recipient keeps 

the message in his or her Outlook mailbox, a reminder 

will be displayed at the time you specify. 

You can also 

attach a follow-

up flag for your 

recipients by 

using the Flag 

for Recipients

command, 

highlighted in 

the picture. 

Respond to a message

Making the Switch

E-mail isn’t just 

about sending…

…it’s also about 

receiving and 

replying. 

When you reply from an open message, you’ll use the 

buttons in the Respond group on the Message tab of 

the Ribbon.

You’ll notice that what’s on the Ribbon in a received 

message is different from what’s on it for a new mail 

message.



2/22/2008

19

Make time and remember to do things

Making the Switch

Outlook isn’t 

just about e-

mail. 

It’s also about 

organizing your 

time, which you 

do in the 

calendar. 

When you create or open an item in your calendar, you’ll 

see that the Ribbon shows groups and commands 

appropriate for helping you manage your time.

Make time and remember to do things

Making the Switch

When you 

create any type 

of calendar 

entry, a 

reminder is set 

automatically. 

To change the reminder time for an appointment:

1

2

On the Appointment tab, click the arrow to open the 

Reminder list and then select a time.

Once you’ve made a change, click Save & Close on the 

far left of the Ribbon.
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Want to create a meeting? Invite others

Making the Switch

An 

appointment is 

just for 

yourself. 

When others 

are involved, 

create a 

meeting. 

1

2

On the Appointment tab, click Invite Attendees.

A To button and box appear. Type names directly in the 

box or click the To button to add invitees by selecting 

from a list.

Want to create a meeting? Invite others

Making the Switch

An appointment 

is just for 

yourself. 

When others are 

involved, create 

a meeting. 

3 Once you’ve entered all of the meeting details, click 

Send to send the invitation to the other meeting 

participants.
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Work with a contact

Making the Switch

When you open 

or edit a 

contact, you’ll 

use the buttons 

in the Show

group to show 

or hide more 

information 

about a contact. 

For example, if you want to note the birthday or 

anniversary of a contact, click the Details button and 

then select the appropriate date next to Birthday or 

Anniversary.

Send and Receive Attachment and 
Pictures
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Send and receive attachments and pictures

Making the Switch

Sending and 

receiving 

attached files in 

Outlook 2007 is 

just as easy as 

it’s always 

been—and in 

some ways, 

even easier.

When you receive attached pictures or Microsoft Office 

files, you’ll be able to use the Attachment Previewer to 

preview those attachments right in the Outlook 

Reading Pane. 

And if you’re sending pictures, the Ribbon will help you 

send them just the way you want them.

Include an attachment

Making the Switch

Including an 

attached 

document or 

picture with your 

message is 

easier than ever. 

Just as you’ve always done, you’ll begin by creating a 

new message. Then you’ll use the Attach File

command on the Ribbon.
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Include an attachment

Making the Switch

Where you’ll 

find Attach File

The picture shows it on the Insert tab.

Including an 

attachment is a 

common activity, 

so you’ll find 

Attach File on 

both the 

Message tab 

and the Insert

tab. 

Include an attachment

Making the Switch

You can’t 

attach just 

anything

This behavior is unchanged from earlier versions. 

Outlook will 

block certain 

types of file 

attachments. 
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Include a picture in line with text

Making the Switch

In Outlook, it’s 

easy to send 

pictures in the 

body of your e-

mail messages 

instead of as 

separately 

attached files. 

1

2

Click the Picture command on the Insert tab.

As shown in the illustration, you’ll see a picture in the 

body of the message. 

To do this:

Picture this: tabs that come and go

Making the Switch

Some tabs 

only appear 

when you do 

specific tasks. 

1

2

3

Select a picture that you’ve inserted into a message…

…you’ll see that Picture Tools appear on the Ribbon.

The Format tab includes commands that you can use to 

edit the picture before you send it.

For example, when you:
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Preview attachments before you open them

Making the Switch

In Outlook 2007, 

you’ll receive 

attachments just 

as you did in 

earlier versions.

Now, some 

attached files 

can be 

previewed right 

from the 

Reading Pane. 
Suppose someone sends you two Microsoft Office 

Visio® diagrams as attachments, but you only care about 

the one that shows the new training room in your 

building.

How could you quickly decide which file to open or save 

to your hard disk?

Preview attachments before you open them

Making the Switch

As the picture 

shows, 

attachment 

previewing 

could be your 

answer.

Attachment previewing allows you to display previews of 

certain file types right from the Outlook Reading Pane. 

You can do this without having to open the attached 

files.

To preview an attachment, click its icon. The attachment 

preview appears in the Reading Pane.
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How others receive attachments that you send

Making the Switch

When you use 

Outlook 2007, 

people will 

receive attached 

files that you 

send just as 

they always 

have. 

What has changed is the file format used by some 2007 

Office system programs.

Attachments that you send or receive may use this new 

format, which keeps file sizes smaller and helps keep 

files safer. Outlook fully supports sending and receiving 

files that use the new formats.

How others can view attachments that you send

Making the Switch

If you’ll be 

sending a Word 

2007, Excel 

2007, or 

PowerPoint 

2007 file to 

someone who 

hasn’t yet 

upgraded to the 

2007 release of 

Office, there are 

two options. 
• You can save the file in the 97-2003 file format before 

you send it. 

• Colleagues who have Microsoft Office versions 2000 

through 2003 can open, edit, and save 2007 files by 

installing the Microsoft Office Compatibility Pack for 

2007 Office Word, Excel, and PowerPoint File 

Formats, offered free by Microsoft. 
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Modified Functionality

 For Follow Up Flags – replaced by task flags and color 

categories.  No longer see colored flags in the mail view.  If you 

flagged items in the earlier version of Outlook to indicate that 

they were important you should now use color categories 

instead.  If you used flags to indicate the time at which you 

were to take action on an item, you should now use task flags.

 Follow Up Button – The Follow Up Button and the Flag for 

Follow Up dialog box are replaced by a drop-down menu.  The 

flagging feature has been enhanced.

Making the Switch

Discontinued Features 

 Task Pad – no longer see in the calendar, replaced by the new 

To-Do Bar

Meeting Updates – meeting organizer can no longer change 

the time/location without sending an update nor delete a 

meeting without notifying people

 Free/Busy Bar – Removed on calendar items if the item is 

marked as busy.  

Meetings Icon – Removed from calendar items.

Making the Switch
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Class Evaluation

http://www.lib.ku.edu/instruction/evaluation

Making the Switch

For more information contact

Instructional Services:
http://www.infotraining.ku.edu

training@ku.edu

864-0410

Making the Switch
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